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1 Introduction
This user guide explains how to use Beckhoff TwinCAT NCI or CNC in conjunction with Triamec EtherCAT
drives. EtherCAT drives from Triamec are marked with the letter “E” after the name, i.e., TSD80E, TS-
D85E, TSD130E, TSD350E, TS360E, TS710E.

The TriaLink series TS35x, TSP700, TSD80T etc. are not covered with this guide. See (1) on how to set up
these drives with TwinCAT. 

2 Configuring the drives
Before a drive can be used with TwinCAT, the drive has to be configured with the TAM System Explorer.
See the Setup Guide(2) for how to setup the drive parameter, install new firmware and for how to save
the parameters persistently on the drive.

Remarks:

 For configuration the drive has to be connected with the PC  through a USB or Ethernet connection
and the TAM System Explorer has to be installed on the connected PC. It is recommended to set
“File > Preferences > Startup > Acquired Adapters” to “Triamec devices over USB” or “Triamec De-
vices over Ethernet” to accelerate booting. The EtherCAT control system PC does not require an in-
stallation of the TAM System Explorer if it is not intended to used for configuration or debugging of
the drive.

 When using the TAM System Explorer to configure the drive, the drive must not follow the EtherCAT
commands. Therefore set  Axes[].Commands.General.OverwriteControlSystem to 1 or, when using
the Axis Module, use the button “Attach” to set the OverwriteControlSystem command. Don't forget
to reset the command when the configuration is done.

 Set Parameters.PositionController.PositionUnit for each axis for proper position scaling as discussed
in chapter 6.1.

 To not loose the settings on a power-down of the dive save the configuration persistent on the drive
as described in (2). Later changes of the configuration need to be persisted again to not be lost after
a power-down. Also save the configuration as a *.TAMcfg file on the PC.

1 SWTC_TwinCAT-UserGuide_EP***.pdf in Help > Documentation/Software. 
2 SW_TSD-TSP360-TSP710-Setup-Guide_EP***.pdf  in Help > Documentation/Software
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3 Preparation of TwinCAT and DC
Copy the device description file (ESI) “Triamec.xml” to “C:\TwinCAT\3.1\Config\Io\EtherCAT”. If TwinCAT
was already open, choose “Twincat/EtherCAT Devices/Reload Device Descriptions”. 

Open a new Twincat Project and add an Ethercat Adapter. 

 IO/Devices/Add new item
 Ethercat/Ethercat Master

If there is no EtherCAT driver installed yet, try the menu “TwinCAT/Show Realtime Ethernet Compatible
Devices” in the TwinCAT environment. Make sure the LLDP Protocol is disabled (3). 

Make sure the cycle time of Distributed Clock (DC) Sync is a multiple of 100µs. Choose for example

 System/RealTime/Settings/BaseTime 200µs
 For NCI: Choose MOTION/NC-Task1 SAF/Task/CycleTicks=2 400µs (must be n* 100µs)
 For CNC: Choose MOTION/CNC Task GEO/Task/Cycle Time=2 400µs (must be n* 100µs)

Consider  the sync  shift settings at  EtherCAT/EtherCAT/AdvancedSettings/DistributedClock/ SyncShift-
Time if the jitter on the host PC is large. 

Set Drive/EtherCAT/AdvancedSettings/DistributedClock/”UseAsPotentialReferenceClock”

4 Drive setup in TwinCAT
On the EtherCAT master, choose “Add New Item” and choose “Triamec Motion AG/Drives/TriamecDu-
alDrive”. You will be asked, if new NCI-Axes should be added. Answer

 yes, if you intend to use NCI
 no, if you intend to use CNC

If  you  need  additional  cyclic  data,
open Slots in the Ethercat drive. Use
the  left  arrow  to  add  your  choice.
Choose to

 Change the axis  from default  to
touchProbe,  if  you  want  to  use
the TwinCAT touchProbe feature. 

 Open the first extension and se-
lect one choice from the right list
for  integer  or  float  variables.
Check AN104 on how to use this
feature. 

3 NetworkConnections/Properties/MicrosoftLLDPProtocolDriver is disabled. 
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4.1 Using the NCI
If you answered “yes” in the “Add new item” dialog above, a new NCI axis was added for every axis in
the drive and connections were made between the drive and the NCI. Consider

 NciAxis.Parameter.Dynamics: Set the dynamic Parameters
 NciAxis.Parameter.OtherSettings.CoupleSlaveToActualValuesIfNotEnabled TRUE

Choose Twincat/ActivateConfiguration to run Twincat. 

Then the NCI interface should look like

First, enable is off (Freigaben are not selected). You can move the axis by hand and see the actual posi-
tion reflect the correct position. If the actual position is gray, the axis state is not valid. Make sure the
drive is in the EtherCAT operational state (see drive Online) and the drive is not in an error state (see
cyclic signal “error” or the COE-online objects 0x6035 (axis 0) and 0x683F (axis 1).

Now enable the axis using Freigaben and Regler, Vorschub+, Vorschub-, Override 100%.

Press + and - to move the axis. The axis should move and the actual position should change accordingly.
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4.2 Using the CNC
Attach the CNC using “Add new Item” on the MOTION node. 

Attach an axis using “Add new item” on the MOTION/CNC-Task GEO/Axes node. 

Select the Triamec Axis using “Link To” and make sure FeedAxis is selected. Choose the Parameter Sec-
tion and add the line "customer.val[0]  0x100 ( P-AXIS-00510 : Free user defined values") for proper
function of the HMI with Triamec Devices. 

Attach a channel (Kanal) using “Add new item” on the MOTION/CNC-Task GEO node. 

Choose Twincat/ActivateConfiguration to run TwinCAT. 

The axes will not be enabled yet. Each axis can be moved by hand and the ActualPosition should change
correctly in the CNC window.

Enabling the axes requires an HLI command to the CNC. An example PLC program is available in the 
Sample code.
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Open the CNC channel control window: CNC-Task GEO/Kanal_1/Online. 

Switch to Operation mode “Manual”. Select the first axis. Press + and - to move the axis. The axis should
move and the actual position should change accordingly. The position “DistanceToGo” should reach 
zero at standstill.

Configure

 the CNC channel in CNC-Konfiguration/CNC-Task GEO/Kanal_1 and
 the CNC axes in CNC-Konfiguration/CNC-Task GEO/Achsen/Achse_n/Parameter

as shown in the CNC-documentation.

Please note the following behavior of the CNC module: If the drive enters an error state, the CNC will
also enter its error state but it will remain at ModeOfOperation8 and ControlWord0x1F. If the drive er-
ror is cleared using the CNC-reset, everything is fine. 

If, instead, the drive error is cleared directly on the drive side using USB or Ethernet access, the drive
will clear its error and find the controlWord 0x1F. So it will go back to coupled state, where it follows
the commanded positions from the CNC. The CNC on the other side is still in error state and will track
its commanded position to the actual position of the drive. This chasing condition can lead to errors or
noise. Therefore, we recommend to clear errors always using the CNC reset. 

If an EtherCAT axis is removed and newly installed under the TwinCAT EtherCAT adapter, the user does
not want to generate a new CNC axis. In this situation the following changes must be done manually:

 The Axis must again be connected to the CNC in Motion/CNC/Axis/Configuration/LinkTo
 The sync-0 unit of the EtherCAT axis must be assigned again to the GEO-Task in Adapter/EtherCAT/

SyncUnitAssignment 

5 Identification
Triamec drives support the EtherCAT “Explicit Device Identification” method (FW>=4.4.0). This requires
the ESI-File Triamec1.4.xml. Setup the address in the drive register  General/Parameters/LinkAddress
and make the parameter persistent (chapter 2).

Setup the address as “Identification Value” in the TwinCAT EtherCAT section of the drive (see figure be-
low). If this value is not changeable, the ESI-File version might be smaller than 1.4. Then open the ad-
vanced Settings dialog and select General/Behavior/CheckIdentification. 
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Then specify “Explicit Device Identification” in the same dialog under General/Identification. 

6 Positions

6.1 Choose position scaling
EtherCAT uses integer32 for positions whereas Triamec drives use the double format representing SI
units (double meter or rad or similar). Therefore the drives need to convert the double to integer. 

The standard scale factor of EtherCAT is 10'000 inc/mm or 10'000 inc/degree. Since the conversion fac-
tor depends on the axis type (linear or rotative), the drives need to know their axis unit. Specify the axis
unit using Parameters.PositionController.PositionUnits in the drive axis configuration.

To  change  the  default  scaling,  use  the  startup  parameter  Feed  (0x6092.01)  for  the  first  axis  and
0x6892.01 for the second axis. Its units are inc/mm or inc/degree. It is part of the startup parameter list
as shown below. The standard is 10'000. To get for example 1nm resolution, choose the value 1000'000.
Be aware that this reduces the maximum possible position to 231*1nm = 2.1m. 

This changes the scale at the interface. The TwinCAT path planner modules must also know this scaling 
factor:

CNC

If a CNC is attached adapt the CNC axis parameter (see figure below)

getriebe[0].wegaufz 1 P-AXIS-00234 : Path resolution of the measuring system (num).

The unit of this parameter is 10'000 inc/mm or inc/degree. Its default is 1. Use this equation for the val-
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ues of the drive and CNC parameters

0x6092.01 = wegaufz * 10'000 

NCI

Another use case is NCI. Lets assume a finer resolution of 1nm.  

 Set the scale of the EtherCAT positions to 1'000'000 using 0x6092.01 as shown above.
 Set NC/Achsen/Achse_N/Achse_N_Enc/Parameter/ScalingFactorNumerator to 1E-6.

Select the row and use “Download, Save” to save the settings.
Reload the solution to activate the changes

6.2 CSP mode
The standard mode of operation is CSP, where commanded positions are expected cyclically. There are
three interpolation modes, specified with the drive register Axes[].Parameters.PathPlanner.StreamInter-
polatorMode.

 Polynom3A A 3th order recursive polynom into the last three positions  
 Polynom4A A 4th order polynom exactly fitting into the last five positions (legacy)
 BSpline3A A cubic B-Spline of the last three positions

Choose Polynom3A in standard situations with a smooth target path. Choose BSpline3A in situations
with not physical target positions. 

6.3 Modulo and Spindel
If  the Triamec parameters Axes[]/Parameters/PathPlanner/ModuloPositionMaximum and ..Minimum
are unequal to 0.0, the axis runs in modulo mode. In CSP mode, it expects commanded positions within
this range. The actual positions from the encoders will wrap as soon as the respective commanded po-
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sitions wrap. 

The commanded velocity is not considered directly for path generation in CSP mode. However, it is con-
sidered at higher speeds to decide, what modulo wrap should be taken (FW 4.5.0). If, for example, the
NC-rate is 1ms and the target speed is larger than 30’000 turns/min, the drive will face more than half a
modulo per position update and it cannot resolve correct positions, if velocities are not provided. If the
velocity is correctly provided, the drive will decide for the correct modulo wrap in this case. See CSV
mode for the required velocity scaling. 

Drive

Set the modulo ranges (if PositionUnits is on radian). 

 Axis.Parameters.PathPlanner.ModuloPositionMaximum2*pi
 Axis.Parameters.PathPlanner.ModuloPositionMinimum 0.0

CNC

For details on CNC axis, spindle, and channel settings see the Beckhoff or CNC documentation. If the
axis is rotational with the CNC in units of 0.0001° and should get a 360° Modulo, set: 

 kenngr.achs_typ ROTATOR (P-AXIS-00018 Type, 2 (ROTATOR) or 4 (SPINDLE))
 kenngr.achs_mode 0x4 (P-AXIS-00015 Modulo)
 getriebe[i].moduloo 3600000 (P-AXIS-00126 : [10-4degree] Upper modulo limit)
 getriebe[i].modulou 0 (P-AXIS-00127 : [10-4degree] Lower modulo limit)

For CNC Spindel mode consider Axis-Parameters (over-write some settings above). The 720° modulo al-
lows faster speed at slow update rates of the position:

 kenngr.achs_typ SPINDLE (P-AXIS-00018 Type, 2 (ROTATOR) or 4 (SPINDLE))
 kenngr.vb_prozent 100 (P-AXIS-00217 [0.1 %]Factor for speed reached) 
 getriebe[0].vb_min_null 1000 (P-AXIS-00216 [10-3Grad/s] Drehzahl null (Spindel))
 getriebe[0].beschl_kennlinie.typ  0 (P-AXIS-00202 Type of the acceleration curve )
 getriebe[i].moduloo 7200000 (P-AXIS-00126 : [10-4degree] Upper modulo limit)
 antr.mode_act_pos 2 (P-AXIS-00122)
 antr.mode_cmd_pos 2 (P-AXIS-00123)
 ?antr.drive_encoder_range 3600000 (4)

and channel parameters

 spdl_anzahl 1 (P-CHAN-00082 Spindelanzahl)
 main_spindle_ax_nr 1 (P-CHAN-00051 Logical axis number main spindle)
 main_spindle_name S (P-CHAN-00053 Bezeichnung der Hauptspindel)
 spindel[0].log_achs_nr 1 (P-CHAN-00036  Logical axis number of the Spindel)
 spindel[0].bezeichnung S1 (P-CHAN-00007 Bezeichnung der Spindel)
 cax_face_id 2 (Fräsmaschinen)
 main_spindle_gear_change 0

NCI

4 This value has to be scaled with getriebe[..].wegaufz/getriebe[..].wegaufn.
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See Beckhoff documentation on using Modulo Moves. Set NCI/Axis/Enc/Parameters

 ScalingFactorNumerator = 0.0001
 ScalingFactorDenominator = 1.0
 Modulo Factor = 360
 EncderMask = 0x36EE80 (3600000)
 EncderSubMask = 0x36EE80 (3600000)
 ReferenceSystem = Absolute(modulo)
 See Beckhoff documentation on using Modul

and in NC/Axis/Drive/Parameters

 OutputScalingFactor (Velocity) to 429.5 = (2^32) / (10^7)

and set Axis/Settings/Unit=Degree and activate Axis/Settings/modulo. 

6.4 CSV mode
The standard mode of operation is CSP Mode (8), where cyclic positions are commanded at the inter -
face. With FW Release 4.5.0 CSV mode (9) is supported too, where cyclic velocities are commanded. 

The resolution of the velocities are scaled by the same factor as for CSP mode: If for a rotational axis

 the feed object 0x6092.01 is 10000 inc/degree,
 a position of 10000 inc will correspond to 1 degree and
 a velocity of 10000 inc will correspond to 1 degree/s

The drive side interpolation uses cubic B-splines in the target velocity and integrates these to a 4 th order
polynom in the position. To facilitate switching back from CSV mode to CSP mode, the signal General/
Signals/EtherCAT/targetPositionError is provided, which is the deviation between expected position and
commanded position. 

6.5 Referencing (Homing)
Absolute encoders return the correct position without a reference move. See AN107 for setup. With
Twincat-CNC  pathplanner,  make  sure  to  set  the  kenngr.set_refpos_mode to  “OFFSET”  and
kenngr.set_refpos_offset to 0 to avoid any difference between CNC and drive positions. 

Drive controlled homing is described in AN107. See TwinCAT sample code for using this mode. 

Reference moves controlled by TwinCAT are used to determine the position difference between drive
position and TwinCAT position. This is then taken into account by adding an offset between the inter-
face data and the display data. The drive positions are not referenced in this case. 
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7 Control and Status Word
Supported "modes of operation" for firmware 4.5.0 are PP(1), PV(3), HM(6), CSP(8), CSV(9). The Ether-
CAT control word depends on the mode of operation. 

Bit Register

0 SwitchOn

1 EnableVoltage

2 QuickStop

3 EnableOperation For modes of operation CSP, CSV

PP [4]
PV [4]
HM [4]

NewSetpoint
newSetpoint
start homing

PP [5]
CSP [5..6]

ChangeSetImmediately
OutputCycleCounter

PP [6] relativeTargetValue

7 FaultReset

PP [8]
PV [8]
HM [8]
CSP [8]
CSV [8]

halt
halt
halt
no function
no function

PP [9] changeOnSetPoint

The EtherCAT status word

Bit Register

0
1
2

ReadyToSwitchOn
SwitchedOn
OperationEnabled

3 fault

5 quick stop 1 = quick stop is not active

6 switchOnDisabled

7 warning

8 follow me manufacturer specific

[10] PP+PV
[10] HM
[10] CSP
[10] CSV

TargetReached / velocityIsZero
TargetReached / velocityIsZero
ToggleStatus
Toggle status

if halt=0 / 1
if halt=0 / 1
not implemented
not implemented

[11] internal limit is active

[12] PP+PV
[12] HM
[12] CSP
[12] CSV

SetPointAcknowledge
Homing done
DriveFollowsTheCommandValue 
DriveFollowsTheCommandValue 

previous setpoint still in process

[12] Kap 6.2 of ETG6010_V1i1i0
[12] Kap 6.2 of ETG6010_V1i1i0
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[13] PP+PV
[13] HM
[13] CSP 

FollowingError
Homing error
ExtendedToggle

[15] referenceDone manufacturer specific

A typical start sequence for the mode of operation 8=CSP is

status control

0x121 0
2

ReadyToSwitchOn  
EnableVoltage

0x121
3

ReadyToSwitchOn
EnableVoltage+SwitchOn

0x127
0xB

Enabled
EnableOperation

0x1027 CoupledMotion

Please note the following behaviour of Target position versus actual position in this sequence: As long
as bit 0x100=followMe is set, the drive actual position does not follow the target position. Instead, the
control system is expected to track the actual position by setting target=actual. 

During the enabling phase, the actual position may be changing due to the axis phasing procedure until
the drive sets bits 1+2 (state=0x127) to indicate, it is enabled. Now the control system sets the com-
mand bit 0x8 as it wants to control the target position itself. At the same moment, it should stop track -
ing the actual position. Now the drive sets bit 0x1000 and resets bit 0x100 to indicate, it is ready to fol -
low the target positions. If the control system continues to track the actual position at this stage, this
will cause a chasing behaviour. 

8 Registers
Triamec EtherCAT drives support two register ranges. Both ranges are accessed the same way as shown
in Application note AN109. The first set is published to TwinCAT by the COE-Information method. As a
consequence, these are shown in the TwinCAT tab “COE-Online”. These are listed in the table below. A
second range is not shown directly. This large set of registers is usually accessed using the TAM System
Explorer when tuning the axis-motor-drive system. Nevertheless, these registers can be accessed from
TwinCAT using the same function blocks. Finding there addresses is described in AN109. A sample of ac-
cessing a drive register is shown in the NCI TwinCAT sample project. A description of how to setup cyclic
telegrams is explained in AN104. 

8.1 Published COE Registers
For axis specific registers use the axis index a={0, 1} in the Index field.  For PDO extensions use the ex-
tension index k={0, ..3}. (FW Release 0.8.8)

Index Register

0x1001 errorRegister returns 0x8001 on any error. See 0x603F on per-axis-errors. 
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0x1008 devicename for example TSD80E

0x1009 hardwareversion String major.minor

0x100A softwareversion String major.minor.bugfix {-beta means firmware is in beta state}

0x1018 identity 02: productCode
03: HardwareRev ([0..7]=minor, [8..15]=major)
04: SerialNumber

0x1600 + a*0x10
0x1601 + a*0x10
0x1604 + a*0x10

RxPDO mappings for AxisPath

0x1622 + k*0x10
0x1623 + k*0x10

RxPDO extensions See AN104

0x1A00 + a*0x10
0x1A01 + a*0x10
0x1A04 + a*0x10

TxPDO mappings for AxisPath

0x1A22 + k*0x10
0x1A23 + k*0x10

TxPDO extensions See AN104

0x6040 + a*0x800
0x6041 + a*0x800

The EtherCAT control word
The EtherCAT status word

0x603F + a*0x800 The axis error. See table below. 

0x6064 + a*0x800 Position actual

0x606C + a*0x800 Velocity Actual

0x607A + a*0x800 Target Position

0x6092 + a*0x800 FeedConstant 01:Feed, see chapter 6.1

0x60FF + a*0x800 Target Velocity

A typical content of the TxPdoAssign arrays for two axes and two extensions would be:
RxPdoAssign: 0x1C12 = {4, {0x1601, 0x1611, 0x1623, 0x1633}}
TxPdoAssign: 0x1C13 = {4, {0x1A01, 0x1A11, 0x1A23, 0x1A33}}

Error codes

The axis error 0x603F is also transmitted cyclically. See table below for the error codes. Besides of this
integer representation of an error, it is also possible to see a string representation using the TwinCAT
Event-Logger-Method. An event file and sample code to show the messages is provided in the sample
code TwinCAT project. The TwinCAT event bar executable is at (5). 

error Short form Description

0 None No error

1 PositionErrorLimit The position error limit of the position controller is exceeded.

5 EncoderSubresolutionError The  sub-resolution  of  the  encoder  is  ambiguous.  Possible  cause:
faulty wiring.

6 EnablingNoMotorAxis Enabling of an Axis with no motor configuration is not possible.

5 C:\TwinCAT\3.1\Components\TcEventLogger\TcEventBar.exe. 
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7 EncoderError Encoder works not as expected. (no or too low signal from encoder)

8 EncoderShort The encoder supply is shorted.

9 DigOutputShort A digital output is shorted.

10 MotorI2t The I2t limit of the motor is exceeded.

11 PowerBridgeI2tLimit The I2t limit of the power bridge is exceeded.

12 MotorPeakCurrentLimit The peak current limit of the motor is exceeded.

13 PowerBridgePeakCurrentLimit The peak current limit of the power bridge is exceeded.

14 EncoderConfigurationError Two encoders of different type point to the same hardware.

15 OptionModuleFailure An encoder points to an option module which is not present or a
present option module did not boot.

16 EncoderDatabusError Digital Encoder data bus not connected, or communication failed.

17 EncoderNotSupported This encoder type is not supported.

18 NoDigitalEncoderPersistency The encoder does not contain persistency data. Get the reference
and use AN107 to save.

19 PhaseShort A short  (phase-to-phase  or  phase-to-earth)  was detected in  PWM
during bridge power-up.

20 SynchronizationLost The stream interpolaton synchronization is lost.

21 GantryTrackingError The  distance  between  the  two  gantry  axes  was  larger  than  the
GantryDeviationLimit

22 Commutation600HzLimit The 600Hz commutation frequency limit of this product was reached

23 UnspecifiedPositionUnit The position unit is not specified or not known

24 MotorTemperatureLimit The motor temperature is out of specification

25 AxisParameterError A parameter of this axis is unknown

26 AxisCommandError A command of this axis is unknown

66 ComputingTime The limit of the computing time is exceeded. 

69 BridgeVoltageOutOfRange The power bridge voltage is out of range. 

70 BridgeOverCurrentLimit The limit of the power bridge current is exceeded. 

71 TemperatureLimit The limit of a temperatue is exceeded.

72 VoltageOutOfRange At least one operating voltage is out ouf range.

73 ExternalError The external error is triggered by the user.

74 NoValidTamaCodeAvailable Running Tama without valid Tama code error.

75 InvalidPersistentParameters Persistent  parameters  are  not  compatible  with  running
firmware.

76 TamaOutOfMemory While executing a Tama program, the program memory be-
came full during heap allocation. Memory is typically allo-
cated on the heap when creating new instances of refer-
ence types, including arrays.

77 TamaDivisionByZero While executing a Tama program, an attempt was made to
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divide by zero.

78 TamaNullReference While executing a Tama program, an object property was
requested, but there was a null reference.

79 TamaIndexOutOfRange While executing a Tama program, an array element index
was outside the range of the array.

80 TamaCorruptedState While executing a Tama program, Tama program state was
corrupted. This value is returned when an unknown opera-
tion code is encountered.

81 MonitorIsNotRunning Hardware monitor on the device is not running.

84 SafeTorqueOffActiveWarning SafeTorqueOff (STO) is active.

85 SafeTorqueOffInconsistent SafeTorqueOff (STO) safe mode due to inconsistent chan-
nels detected (only one contact is closed).

86 SafeTorqueOffStartupTestFailure SafeTorqueOff (STO) safe mode due to a Startup test failure.

87 SafeTorqueOffPulseTestFailure SafeTorqueOff (STO) safe mode due to a Pulse-Test failure.

88 SafeTorqueOffTemperatureLimit SafeTorqueOff (STO) safe mode due to Temperature limit on
Logic Monitor.

91 PowerLinesNotOk Power lines are not OK. Not all power lines available or line
disturbance.

92 CommandError A Command was not successful

93 ParameterError Found an unknown or inconsistent Parameter

8.2 Trouble Shooter
On the TwinCAT side, check

 C:\TwinCAT\3.1\Config\Io\EtherCAT\Triamec*.xml
 TwinCAT/EtherCAT Devices/Reload Device Descriptions
 Under IO/Devices/EtherCAT/Drive check "Slots", "Startup", and NC-A etc

For general information relevant for the EtherCAT link, see

 General/Signals/EtherCAT/LinkPll/State (should be DcMaster or DcSlave)
 Axes[0]/Parameters/PositionController/PositionUnit should be specified
 Axes[0]/Commands/PathPlanner/StreamRate
 Axes[0]/Signals/General/EtherCAT/

If EtherCAT does not control an axis as expected, check the following

 The EtherCAT state of the drive must be OP (Operational).
 The Triamec command register Axes[].Commands.General.OverwriteControlSystem must be zero,

which is its default value. A value 1 is used to control the drive using the TAM System Explorer and
disables EtherCAT command requests. 
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 The drive parameter  General.Parameters.Standalone must be False. The value True allows using
the drive without a Link and disables EtherCAT command requests and EtherCAT synchronization.
Also, it suppresses the error LinkNotReady. 

 Make  sure,  Axes[0]/Parameters/PositionController/MasterPositionSource points  to  the  correct
encoder and Axes[0]/Parameters/PositionController/PositionUnit is correctly set. 

 Check the following drive signals visible at the EtherCAT interface and in the TAM System Explorer
register:
Axes[]/Signals/General/EtherCAT/ErrorCombined 
Axes[]/Signals/General/StateMerged
Axes[]/Signals/General/EtherCAT/ControlWord. 

8.3 Non standard
The hardware revision register 0x1018:03 reserves 8 bits for the minor revision. The CAN standard
specifies 16 bits (EN 50325). 

The register Torque (0x6077) is in absolute Units of mA. CAN does not specify the Unit, but specifies
that the value should be relative to NominalTorque.

Dokument Revision

Version Date Editor Comment

001 16.11.16 mvx First Release

002 2017-06-16 mvx Release with Homing

003 2017-11-20 mvx Reference to AN109, add status and control word content

004 2018-11-06 dg Chapter Modulo enhanced.

005 2019-02-12 mvx Explicit Device Identification

006 2019-04-18 mvx Velocity modes of operation

007 2019-09-23 dg Synchronized with TSD User Guide EP001

008 2020-05-14 mvx Added CNC Spindel-Settings (not published yet) and Triamec-Parameter in CNC
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